RIFERIMENTO: AICA ECDLGIS Syllabus Modulo 3 QGIS — 3.2 Dati ¢ attributi nei GIS- 3.2.2 Gestione degli attributi — 3.2.2.1 Aprire, chiudere la tabella degli attributi

3.2.2.1 Aprire, chiudere la tabella degli attributi

Ipotesi:
e Dati nella cartella ECDLGIS_SYLLABUS (percorso: C:\GISeQGIS_DATI\ECDLGIS SYLLABUS)
«  Progetti presenti nella cartella PG ECDLGIS _SYLLABUS (percorso: C:\GISeQGIS_PROGETTI\PG_ECDLGIS _SYLLABUS)

Carichiamo il progetto PG_SIL._Municipi_Comuni_ComuniDati REGIONE_3raster e attiviamo tutti i layer:

(3} PG_SYL_Municipi_Comuni_ComuniDati_REGIONE_3raster — QGIS [ECDL] - O X

Progetto  Modifica Visualizza Layer Impostazioni Plugins Vettore Raster Database Web Mesh  Progessing  Guida

DEBRERH 98 ASRPP

Ni-@a-G-0 ¥

: Layer @@
Vo vaeva-310
wo PROVINCE 1991

V| PROVINCE 2011

@5 V| O PuntiCOMUNI

9 E5 comuni_paTI

5] V|| | coMunI_1991_2011
f » [v] 3 IGM_AICA_ENEA_TOSC_100k
© ) v 3 AGEA_TOSC_OFC_2013_col 30
\/E » [¥] " TINITALY_TOSC_RASTER 30
@ -

L Digita per localizzare (Ctrl-+) rding| 1525143 4689070 2| 1:2300286 | ™ . 1te d'ingrandimer | 100%: ~| 27c |0,0° +| v visuslizza ¥ EPsG:3003 Q

abbiamo:

* 4 layer vettoriali (shapefile):
©  PROVINCE_1991 (layer poligonale)
o PROVINCE_2011 (layer poligonale)
°o  PuntiCOMUNI (layer puntuale)
o COMUNI_1991_2011 (layer poligonale)

* 1 layer Testo Delimitato (csv)
©  COMUNI_DATI

* 3 layer raster (geotif):
o IGM_AICA_ENEA_TOSC_100k
o AGEA_TOSC_OFC 2013 _col 30
o TINITALY_TOSC_RASTER_30

oltre ai dati di sistema di riferimento, di georeferenziazione e geometrici questi layer hanno dati informativi (attributi).

Attributi dei layer vettoriali

I layer vettoriali hanno una tabella degli attributi contenuta nel file .dbf associato tramite il file .shx al file .shp che contiene la parte
geometrica georiferita dei layer vettoriali (punto, linea, poligono). Le tabelle attributi degli shapefile possono contenere pit colonne
ciascuna delle quali definita da specifica tipologia (stringa, numero intero, numero decimale con specifico numero di decimali, valore
booleano, ..).

Vediamo le diverse modalita per aprire la tabella degli attributi ad esempio di PROVINCE_ 1991, posizionare il puntatore su
PROVINCE 1991 nel pannello [Layer., poi:

®*  Menu Layer » Apri Tabella Attributi P clic sinistro del mouse
® clic sinistro del mouse » Apri Tabella Attributi » clic sinistro del mouse
* Barra degli Strumenti relativi agli Attributi » clic su Apri Tabella Attributi

tutte e tre le opzioni aprono la seguente tabella degli attributi:

By www.giseqgis.it - (2023) Pag. 1
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(2} PROVINCE_1891 — Elementi Totali: S, Filtrati: 9, Selezionati: 0 — [} P

/ e s & A T E S P »
PRO1991 NOME

1 49| LIVORNO

2 50 PISA

3 47 PISTOIA

4 48 FIRENZE

5 45 MASSA CARRA...

6 46 LUCCA

u 53 GROSSETO

8 51 AREZZO

9 52 SIENA

*~ Mostra Tutti gli Elementi _

tabella con 9 elementi (9 poligoni) e 2 campi: PRO1991 campo numerico con il codice provincia del 1991e NOME campo stringa con
il nome della provincia.

Per vedere con maggiori dettagli il formato dei campi: puntatore sul layer PROVINCE 1991 poi  Proprieta... » Campi , risulta:

@ Proprieta Layer — PROVINCE 1991 — Camp =
[q 1 T
(i e E Id -  Nome Alias Tipo Mome tipo Lunghezza Precisione Commento Configurazione
123 0 | PRO1991 Intero (32 bit)  Integer 5 0 -
J\:\\ Sorgente
- abc 1 NOME Teste (stringa)  String 30 0 -

.‘V Simbologia
€7 Etichette

€D Maschere

Ng Vista3D

Diagrammi

Campi

dulo Attributi Y 4|
- Stile b [8]4 Annulla Applica Aiuto |

Per chiudere la tabella degli attributi basta fare clic sulla x in alto a destra:

() PROVINCE 1991 — Elementi Totali: O, Filtrati: 9, Selezionatic 0 — O
/ -l £ T B % D s

PRO1991 NOME
1 49| LIVORNO
2 50 PISA
3 47 PISTOIA
4 48 FIRENZE
5 45 MASSA CARRA..,
6 46 LUCCA
7 53 GROSSETO
8 51 AREZZO
9 52 SIENA
*| Mostra Tutti gli Elementi

Con le stesse modalita si aprono e chiudono le tabelle attributi degli altri shapefile e anche la tabella degli attributi del layer Testo
Delimitato (csv) COMUNI_DATI.

Attributi dei layer raster I layer raster sono costituiti da matrici (righe colonne) di pixel georiferiti generalmente di forma
quadrata/rettangolare, a ciascun pixel ¢ associata una sola informazione (si potrebbe dire un solo attributo).

Informazioni Elementi

. . . . . . . i . . . . .
Gli attributi dei layer raster si possono vedere attivando la funzione & posizionandosi sull’area di estensione del raster
e cliccando con il pulsante sinistro del mouse: si visualizza il singolo attributo del pixel selezionato.

Naturalmente posizionandosi all’esterno dell’area di definizione del raster non si ha alcuna informazione.

La tipologia di attributo presente ¢ correlata al tipo di raster attivo: puo essere una matrice di colori RGB (“immagine fotografica™),
una matrice di quote sul livello del mare (DTM), una matrice risultato di una scansione di mappe cartacee, una matrice di valori
telerilevati (Remote Sensing).

Vediamo come sono definiti e come si visualizzano gli attributi dei 3 raster presenti nel progetto.
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RIFERIMENTO: AICA ECDLGIS Syllabus Modulo 3 QGIS — 3.2 Dati ¢ attributi nei GIS- 3.2.2 Gestione degli attributi — 3.2.2.1 Aprire, chiudere la tabella degli attributi

Layer raster IGM_AICA_ENEA TOSC_100koscana_ 100k : carta IGM in bianco e nero della Toscana 1:100.000 scannerizzata

Selezioniamo solo questo layer e apriamo la visualizzazione informativa * sul pannello Layer :

() *PG_SYL_Municipi_Comuni_ComuniDati_REGIOME 3raster — QGIS [ECDL]

Progetto Modifica Visualizza Layer Impostazioni Plugins Vettore Raster Database Web Mesh Processing Guida

DEEBREY 0P HPPP
- 5 "

Layer @®
o i ® T £ 3 gt

1 proVINCE 1991
PROVINCE 2011
o PuntiCOMUNI
COMUNI_DATI
COMUNI_1991_2011
E.anda 1 (Palette)
1
¥ AGEA_TOSC_OFC_2013_col_30
¥ TINITALY_TOSC_RASTER_30

1

4

SHDAENLPRMS

2| e [00°

Q. Digita per localizzare (Ctrl+K) wdin| 1539204 4753056 | ¢ 1:2035939 ~ | @ tedingrandime | 100%

BabtDOR @ % I

2| V| Visuglizza  #EPscizon: @

11 singolo pixel di 30x30 metri rappresenta la presenza o assenza del colore nero, in questo layer i pixel hanno attributo (Valore) 1

(colore nero) o No Data (colore bianco), viene utilizzata la codifica a 1 byte per pixel.

Posizionandosi sul layer nel  pannello Layer , cliccando con il mouse sul pulsante Proprieta... e aprendo la scheda Simbologia si

ha':

| @ ] w Visualizzazione Banda

Tipo visualizzazione | Valori a Tavolozza/Univod =

Informazioni
Banda Banda 1 (Palette)
:t* Sorgente
| Scala colore Random colors
d SEaiciia Valore Colore Etichetta

m Trasparenza 1
'! Istogramma

Q:/ Visualizzazione

a' Temporale
- Piramidi

Elevazione

m Metadati

EpEEE Classifica || =

. 1

Elimina Tutto

T QGIS Server

w Visualizzazione Layer

Modalita fusione | Normale =
Luminosita {_F 0 = [ Contrasto
Gamma i_F 1,00 = [ Saturazione
Inverti colori [ Scala di grigi | Spento
Tonalita Colora Forza

P Ricampionamento
Stile = oK Annulla

9 Ripristina
0 =
0 =
-
100%

Aiuto

1 Originariamente erano definiti 256 Valori (da 0 a 255) ma 1’unico valore utilizzato era ed ¢ il valore 1, per cui si sono eliminati gli altri potenziali valori.
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Informazioni sul raster si possono avere:
* cliccando con il mouse sul pulsante Proprieta... ncl pannello Layer ¢ aprendo la scheda Informazioni

Generale
Nome IGM_AICA_ENEA TOSC_100k
Percorso
File ausiliari IGM_AICA_ENEA_TOSC_100k.tif.aux.xml
Dimensione totale 60.78 MB
Sorgente dati gdal

Informazioni dalla sorgente

Estensione 1552743.9528639300260693,4672304.3138072397559881 : 1773663.9528639300260693,4926764.3138072397559881
Larghezza 7364

Altezza 8482

Tipo di Dato Byte - intero senza segno di 8 bit

Descrizione Driver GDAL  GTIiff

Metadato Driver GDAL GeoTIFF

Descrizione dell'insieme  C:/GISeQGIS_DATI/ECDLGIS_SYLLABUS/IGM_AICA_ENEA_TOSC_100k.tif
di dati

Compressione
Banda 1 RepresentationType=THEMATIC
STATISTICS_APPROXIMATE=YES
STATISTICS_MAXIMUM=1
STATISTICS_MEAN=1
STATISTICS_MINIMUM=1
STATISTICS_STDDEV=0
STATISTICS_VALID_PERCENT=7.365

Scala: 1
Offset: 0

.

.

Maggiori informazioni e AREA_OR_POINT=Area

Dimensioni X: 7364 Y:.8482 Bande: 1
Origine 1552743.9528639300260693,4926764.3138072397559881
Dimensione Pixel 30.-30

Sistema di riferimento (SR)

Nome EPSG:3003 - Monte Mario / Italy zone 1

Unita metri

Metodo Transverse Mercator

Corpo celeste Earth

Riferimento Statico (si basa su un datum che & fissato sulla placca tettonica)
Bande

Numero bande 1

Numero Banda No-Data Min Max
1 Banda 1 255 1.0000000000 1.0000000000

* scegliendo Processing » Strumenti P Analisi Raster » Report valori univoci del layer raster :

File analizzato: C:/GISeQGIS_DATI/ECDLGIS_SYLLABUS/IGM_AICA_ENEA_TOSC_100k.tif (banda 1)

Estensione: 1552743.9528639300260693,4672304.3138072397559881 : 1773663.9528639300260693,4926764.3138072397559881
Proiezione: EPSG:3003 - Monte Mario / Italy zone 1

Larghezza in pixel: 7364 (unita per pixel 30)

Altezza in pixel: 8482 (unita per pixel 30)

Conteggio pixel totali: 62461448

Conteggio pixel NODATA: 57115970

Valore Conteggio dei pixel Area (m?)

1 5345478 4810930200

Cliccando con QR Informazione Elementi in un punto “bianco” all’interno dei confini regionali risulta Banda 1 Valore = no data:

(2 *PG_SYL_Municipi_Comuni_ComuniDati_REGIONE 3raster — QGIS [ECDL] - O X

Progettc Modifica Visualizza Layer |mpostazioni Plugins Vettgre Raster Database Web Mesh Progessing Guida

NEARRE OBALRPPP :

';.«' a»s %’32 oot e

R
B EE
Vo leaeTre-3®0
'U ~ v " IGM AICA ENEA TOSC 100k E
Banda 1 (Palette)
-] L
9 + [] B AGEA_TOSC.OFC_2013_col 30 -
9| informazioni Risuttati @&
#o RH R G By o»
A [Eemento Valore
~ IGM_AICA_ENEA_TOSC_100k 0
'D ~ |~ IGM_AICA_ENEA_TOSC_100k
Banda 1 no data
@ + (Derivata)
\‘-‘B
V-3 ;
Modalita | Layer Corrente -

Vista | Albero -

Intern rdini| 1636997 4312028 2/ 1:2421644 | ¥ | @ ite dingrandimer| 100% 3| azc [0,0° 2| | visualizza  @EPsGiz003 @
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Cliccando con QR Informazione Elementi in un punto “nero” all’interno dei confini regionali risulta Banda 1 Valore = 1:

(2 *PG_SYL_Municipi_Comuni_ComuniDati_REGIONE_3raster — QG5 [ECDL] - o X
Progetto Meodifica Visualizza Layer |mpostszioni Plugins Vettpre Raster Database Web Mesh Progessing Guida

D AKX Qe PLRPPE L #Z o -=-

HO

@\ 8
o @6
\J; « [l ® T, E = s
'D ~ |V B IGM AICA ENEA TOSC 100k =
Banda 1 (Palette]
& m
- W AGEA_TOSC_OFC 2013 col_30 -
Informazioni Risultati [=ES]
20 g A B~ »
Elemento Valore
~ IGM_AICA_ENEA_TOSC_100k 0
|~ IGM_AICA ENEA_TOSC_100k
Banda 1 1

» (Derivato)

SSHHHAEN®

[ »

Modalita | Layer Corrente =

Vista |Albero  ~

Intern wdini| 1652374 4778711 | 2 1:2421643 |~ | @ ite dingrandimel| 100% 2| adic [0,0° 3V Visusliza @ EPsc:a03 @

Cliccando con % Informazione Elementi in un punto “bianco” all’esterno dei confini regionali ma interno alla estensione del

layer risulta Banda 1 Valore = no data :

() *PG_S¥L_Municipi_Comuni_CemuniDati REGIONE_3raster — QGIS [ECDL] - O e
Progetto Modifica Visualizza Layer |mpostazioni Plugins Vettore Rester Database Web Mesh Progessing Guida
7 % D O IORIORIE) —
0 #? 0eppRPPPE i
i

Layer EE]
Vo legmvyo gm0
'D ~ ¥ " IGM AICA ENEA TOSC 100k =

Banda 1 (Palette)

B L&
9 ~ [ ] W AGEA_TOSC_OFC 2013 col 30 =
2 | \nformazioni Risultat @®
#o 2Ry R Wiva, o»
% Elemento Valore

~ IGM_AICA_ENEA_TOSC_100k 0
‘D * |~ IGM_AICA_ENEA_TOSC_100k

Banda 1 no data

@ + (Derivato)

‘ b

Modalita |Layer Corrente -

Vista | Abero  ~

Interri ardin,| 1593427 4800425 | 9 2| 1:2421844 ~ | @ it dingrandimer| 100% 3| azic [00® 3| V] Visuglizza #EPsG:3003 @

Con ﬂg Informazione Elementi in un punto esterno alla estensione del layer — come gia premesso - risulta nessuna informazione:

() *PG_S¥L_Municipi_Comuni_ComuniDati REGIONE_3raster — QGIS [ECDL] — [u} X
Progetto Modifica Visualizza Layer |mpostazioni Plugins Vettgre Raster Database Web Mesh Progessing Guida
=] 4 1, =) ORIORIG) —
D E ma {I_'j o ~ ;-: > 9 9*" mn T g
o
Layer &]E]
Vo vamti-3H0
'D - |V B IGM AICA ENEA TOSC 100k =
Banda 1 (Palette)
) [ B
9 ~ [] ®® AGEA TOSC OFC 2013 col 30 =
S | nformarioni Risultati =1E)
a = 20 g T B~y »
B [etemento Valere
\i
G
Modalits | Layer Carrente -
Vista | Albero
Digt (CHl+) wdini| 1506289 4796010 | W 2| 12421648 ~ | @ ite dingrandime| 100% +| oz [00° 3|V Visuslzza @ EPsGian: @
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Layer AGEA_TOSC_OFC_2013 col 30 il valore sul singolo pixel di circa 30x30 metri (risoluzione della immagine nella ortofoto
con dimensioni leggermente modificate in 29,99816... x 30,00053... metri a seguito della proiezione in EPSG 3033?) rappresenta il
colore del pixel somma dei tre colori Rosso (Red), Verde (Green) e Blu (Blue), viene utilizzata la codifica a 4 byte per pixel.

Selezioniamo solo questo layer e apriamo la visualizzazione informativa * sul pannello Layer :

Q *PG_SYL_Municipi_Comuni_ComuniDati_REGIONE_3raster — QGIS [ECDL] - [m] X
Plugins Vettore Raster Database Web Mesh Processing Guida

BabtDOR &% Z -&-&

Progetto  Modifica Visualizza

O ELR

Layer Impostazioni

Ve pplPpP®

G- G =
Layer @&
v @& T oA
] PrROVINCE 1991
PROVINCE 2011

© PuntiCOMUNI
COMUNI_DATI
COMUNI_1991_2011

» ¥ IGM_AICA_ENEA_TOSC_100k
M canda 1 (Red)
. Banda 2 (Green)
M canda 3 (Blue)

W TINITALY.TOSC_RASTER_30

Ll

a b@'@@o‘ﬁo\a’ﬁ(’nﬁ

Ll

Y

arding| 1467324 4753584 %’ & ;2300286 T EH ite dingrandimer | 100% >

., Digita per localizzare (Ctrl+K) Az [0,0° < | ¥ visualizza “epscizns @

Posizionandosi sul layer nel pannello Layer , cliccando con il mouse su  Proprieta... e aprendo la scheda Simbeoloegia si ha:

@ Proprieta Layer — AGEA_TOSC_OFC_2013_col_30 — Simbologia >
) Bandarosso | Banda 1 (Red) - =
Informazicni Min |0 Max | 255
_ Banda verde | Banda 2 (Green) -
Sorgente
] Min |0 Max | 255
Simbolegia
Banda blu Banda 3 (Bluz) -
Trasparenza Min |0 Max | 255
Migioramento Stira a MinMax s

Istogramma contrasto

w Impostazioni dei valori di Min e Max
Visualizz
® | Definito dall'utente

i Temporale

Taglio conteggio . | - P
Curmiativo 2,0 +|-198,0 v %
Piramidi i
B Media +/- q |~
SHEEERE deviazione standard = 2,00 -
Metadati Estensione statistiche Intero raster =
Accuratezza Stimato (pidl veloce hd
Legenda (pi )
QGIS Server w Visualizzazione Layer
Modalita fusione | Normale -  Ripristina
Luminosita — ] = [ Contrasty =~ == | 0 =
Gamma - 1,00 = [ Saturazipne == 1] =
Inverti colori [ Scala di grigi | Spento &
Tonalita Colora ~| Forza _) | 100% -
P Ricampionamento
Stile - OK Annulla Applica Aiuto

2 Per la genesi del layer vedere esercizio ES A AGEA_TOSC_OFC_2013_col 30 in QGIS — Altri Esercizi
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Informazioni sul raster si possono avere:

* cliccando con il mouse sul pulsante Proprieta... nel pannello Layer ¢ aprendo la scheda Informazioni

() Proprieta Layer — AGEA_TOSC_OFC_2013_col_30 — Infermazioni X
5 N =
Generale
@ Informazioni Nome AGEA_TOSC_OFC_2013_col_30
5 Percorso C\GISeQGIS_DATNECDLGIS_SYLLABUS\AGEA_TOSC_OFC_2013_col 30 if
) Sorgente ) — i
3 File ausiliari AGEA TOSC_OFC_2013_col_30.tif.aux.xml
” Simbologia Dimensione totale 226.77 MB
Sorgente dati gdal
L@ vasparenza
Informazioni dalla sorgente
B stogramma
Estensione 1554714.7757000001147389,4678283.8815000001341105 : 1771691.4861999999266118,4924798.3015000000596046
Larghezza 7233
a Altezza 8217
W Temporale ) . . . .
° Tipo di Dato Byte - intero senza segno di 8 bit
& Piramidi Descrizione Driver GDAL  GTiff
1 Metadato Driver GDAL GeoTIFF
[ W Elevazione Descrizione dell'insieme  C:/GISeQGIS_DATI/ECDLGIS_SYLLABUS/AGEA_TOSC_OFC_2013_col_30.tif
B veudai di dati .
Compressione
Legenda Banda 1 » STATISTICS_APPROXIMATE=YES
* STATISTICS_MAXIMUM=254
* STATISTICS_MEAN=83.184159085387
» STATISTICS_MINIMUM=7
» STATISTICS_STDDEV=39.362121093867
* STATISTICS_VALID_PERCENT=42.67
e Scala: 1
« Offset: 0
Banda 2 * STATISTICS_APPROXIMATE=YES
* STATISTICS_MAXIMUM=251
e STATISTICS_MEAN=91.984136544061
o STATISTICS_MINIMUM=16
* STATISTICS_STDDEV=30.005702562434
* STATISTICS_VALID_PERCENT=42.67
* Scala:1
* Offset: 0
Banda 3 * STATISTICS_APPROXIMATE=YES
* STATISTICS_MAXIMUM=251
® STATISTICS_MEAN=83.330096540257
® STATISTICS_MINIMUM=20
® STATISTICS_STDDEV=25.277120041586
* STATISTICS_VALID_PERCENT=42.67
* Scala:1
* Offset: 0
Banda 4 « STATISTICS_APPROXIMATE=YES
» STATISTICS_MAXIMUM=255
o STATISTICS_MEAN=108.80139487494
 STATISTICS_MINIMUM=0
« STATISTICS_STDDEV=126.12141834905
« STATISTICS_VALID_PERCENT=100
e Scala: 1
* Offset: 0
Maggiori informazioni « AREA_OR_POINT=Area
Dimensioni X: 7233 Y:.8217 Bande: 4
Origine 1554714.7757000001147389,4924798.3015000000596046
Dimensione Pixel 29.99816265726528641,-30.00053790921259989
Sistema di riferimento (SR)
Nome EP5G:3003 - Monte Mario / Italy zone 1
Unita metri
Metodo Transverse Mercator
Corpo celeste Earth
Riferimento Statico (si basa su un datum che & fissato sulla placca tettonica)
Bande
Numero bande 4
Numero Banda No-Data Min Max
1 Banda 1 n/d 7.0000000000 254.0000000000
2 Banda 2 n/d 16.0000000000 251.0000000000
g Banda 3 n/d 20.0000000000 251.0000000000
4 Banda 4 n/d 0.0000000000 255.0000000000
stle - | oK | Annulla Applica Aiuto

¢ scegliendo Processing B> Strumenti P Analisi Raster » Report valori univoci del layer raster in ogni singola banda,

ad esempio per la banda del “Rosso™:
File analizzato: C:/GISeQGIS_DATI/ECDLGIS_SYLLABUS/AGEA_TOSC_OFC_2013_col_30.tif (banda 1)
Estensione: 1554714.7757000001147389,4678283.8815000001341105 : 1771691.4861999999266118,4924798.3015000000596046
Proiezione: EPSG:3003 - Monte Mario / Italy zone 1
Larghezza in pixel: 7233 (unita per pixel 29.9982)
Altezza in pixel: 8217 (unita per pixel 30.0005)
Conteggio pixel totali: 59433561
Valore Conteggio dei pixel Area ( m?)
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0 33888087 30497957207.02016
11 899.961016006013
21 899.961016006013
32 1799.922032012026
253 109 98095.75074465541
254 131 117894.8930967877
255 19 17099.25930411425

Cliccando con Q% Informazione Elementi all’interno dell’area con pixel derivanti dall’ortofoto (confini regionali) si hanno i tre
valori di composizione del colore nelle prime tre bande RGB (la quarta banda ha valore 255 per tutti i pixel®):

() *PG_SVL_Municipi_Comuni_ComuniDati_REGIONE_3raster — QGIS [ECDL]

Progette Modifica Visualizza Layer |mpostazioni Plugins Vettore Raster Database Web Mesh Progessing Guida

DNEEREY Q8PP HPDRE s tlOR @&

E‘Q - D’Q Q
Layer 2®
Yo (& @ @ T, = =
'D > W 1GM AICA ENEA TOSC 100k
ﬁi ~ |v @ AGEA TOSC OFC 2013 col 30
o M 5anda 1 (Red)
, I =
& Informazieni Risultati 2%
Al ara s & »
Elemento Valore
~ AGEA_TOSC_OFC_2013_col_30 0
@ -| - aceaTosC_OFC_2013 col 30
& Banda 1 ]
@ Banda 2 2
Banda 3 44
% Banda 4 255
+ (Derivato)
Yo"
[ 0
Modalita | Layer Corrente =
Vista | Abero -
Q. Digita per localizzare {Ctrl+k) Intern ordine| 1637737 4818706 % 2| 1:2300286 ~ | {@ 1te dingrandimer | 100% %] =zic [0,0°

#ZE-m-§

2| (V| Visudizza  @EPsG:003 @

Cliccando con Qg Informazione Elementi all’esterno dell’area con pixel derivanti
estensione rettangolare del layer si ha valore 0 per tutte e quattro le bande:

dall’ortofoto ma all’interno dell’area di

() *PG_SVL_Municipi_Comuni_ComuniDati_REGIONE_3raster — QGIS [ECDL]

Progette Modifica Visualizza Layer |mpostazioni Plugins Vettore Raster Database Wieb Mesh Progessing Guida

LhoERRE O poBDPDE EatDOS @
G- 5 - q
e EE]
Vo leamnve-man
B |\ (1% Jom arca enea rosc sooe
B |- v| " AGEA TOSC OFC 2012 col 30
o M 5anda 1 (Rec) =
- e A
,D Informazioni Risultati ®
s P Y 8- »
Elemento. Valore
~ AGEA_TOSC_OFC_2013_col_30 [}
'n « |+ AGEA_TOSC_OFC_2013_col 30
Banda 1 [}
@ Banda 2 0
Banda 3 [}
% Banda 4 0
= + (Derivato)
‘\/:; -
q v
Modalita | Layer Corrente -

Vista | Abero  ~

Q. Digita per localizzare {Ctrl+K) Intern rdin: 1598785 4786449 % 2 1:2300286 ¥ ﬁ ate dingrandimer | 100% %| =zic [0,0°

2| |V visualizza @ EPseizo03 @

p
Cliccando con q% Informazione Elementi all’esterno dell’area di estensione rettangolare del layer non si ha alcuna informazione.

Layer TINITALY _TOSC_RASTER 30 il valore sul singolo pixel di circa 30x30 metri (risoluzione dei tasselli con dimensioni
leggermente modificate in 30,00066812... x 30,00066814... metri a seguito della riproiezione in EPSG 3033*) rappresenta la quota
media s.l.m del terreno nel tassello, viene utilizzata la codifica a 4 byte per ogni tassello (pixel).

Selezioniamo solo questo layer e apriamo la visualizzazione informativa * sul pannello Layer :

3 La quarta banda generalmente ¢ utilizzata per informazioni nell'infrarosso vicino (Near InfraRed), in questo caso non ¢ utilizzata ed ha valore fisso a 255

4 Per la genesi del layer vedere esercizio ES_ A TINITALY TOSC_RASTER 30 in QGIS — Altri Esercizi

By www.giseqgis.it - (2023)
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RIFERIMENTO: AICA ECDLGIS Syllabus Modulo 3 QGIS — 3.2 Dati ¢ attributi nei GIS- 3.2.2 Gestione degli attributi — 3.2.2.1 Aprire, chiudere la tabella degli attributi

Q@ *PG_SYL_Municipi_Comuni_ComuniDati_REGIONE_3raster — QGIS [ECDL] — O

Progette Modifica Visualizza Layer Impostezioni Plugins Vettore Raster Database Web Mesh Progessing  Guida
=M n @ B P = IONIONC)
0 [ HEERE - JOWCR & O OF(C

v
Layer @®
o @ L3 Y: B Dn

] ProVINCE 1991
PROVINCE 2011
o PuntiCOMUNI
5 coMuNI_DATI
COMUNI_1991_2011

Vo
"
&
%
lz% 3 B IGM_AICA_ENEA_TOSC_100k
"]
QD
@
@

&

» ¥ AGEA_TOSC_OFC_2013_col_30

== TINITALY TOSC RASTER 30
Banda 1 (Gray)
= 2.024,81

I -1,10563

o

ading| 1562636 4715809 | % 2| 12326787 | T H ite dingrandimer | 100% | azc (0,0° % V| visualizza ‘.:_%EPSG:SUUB

@

X

@ Proprieta Layer — TINITALY_TOSC_RASTER_30 — Simbolegia =

w Visualizzazione Banda

f?' Informazion Tipo visualizzazione | Banda singola grigia -
a Banda grigio Banda 1 (Gray) -
A Sorgente
- Gradiente colore | Da Nero a Bianco -
% Simbol
ST Min |-1,10563 Max |2024,81
- Miglioramento . .
L‘ Trasparenza e Stira a MinMax i
- Istogramma
p Impostazioni dei valori di Min e Max
¢/ Visualizzazione
0 Temporale Impostazioni Legenda. ..
‘ Piramidi w Visualizzazione Layer
E]' Elevazione Modalita fusione | Normale v #» Ripristina
n‘ Metadati Luminosita S— 0 ¥ || Contrastp e 0 >
= Gamma L 1,00 ¥ | | Saturazione —— 0 >
— Legenda
Inverti colori Scala di grigi | Spento -
UG Seve Tonalita Colora Forza 100%

P Ricampionamento

Stile v O Annulla Applica Aluto

Informazioni sul raster si possono avere:

scegliendo Processing » Strumenti > Analisi Raster » Report valori univoci del layer raster in

File analizzato: C:\GISeQGIS_DATI\ECDLGIS_SYLLABUS\TINITALY TOSC_RASTER_30.tif (banda 1)

Estensione: 1554724.6250000000000000,4678304.1895000003278255 : 1771689.4569000001065433,4924789.6789999995380640
Proiezione: EPSG:3003 - Monte Mario / Italy zone 1

Larghezza in pixel: 7232 (unita per pixel 30.0007)

Altezza in pixel: 8216 (unita per pixel 30.0007)

Conteggio pixel totali: 59418112

Valore Conteggio dei pixel Area ( m?)

-46.8633 1 900.0400887048812
-46.3759 1 900.0400887048812
-46.2526 1 900.0400887048812
-45.614 1 900.0400887048812
... OMISSIS ... (NOTA : quasi sempre 1 solo pixel per ogni valore ! )
2036.26 1 900.0400887048812
2036.75 1 900.0400887048812
2040.16 1 900.0400887048812
204398 1 900.0400887048812

By www.giseqgis.it - (2023)

Posizionandosi sul layer nel pannello Layer , cliccando con il mouse su | Proprieta... e aprendo la scheda |Simbolegia si ha:
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RIFERIMENTO: AICA ECDLGIS Syllabus Modulo 3 QGIS — 3.2 Dati ¢ attributi nei GIS- 3.2.2 Gestione degli attributi — 3.2.2.1 Aprire, chiudere la tabella degli attributi

* cliccando con il mouse sul pulsante Proprieta... nel pannello Layer e aprendo la scheda Informazioni :

Generale
Nome TINITALY_TOSC_RASTER_30
Percorso
File ausiliari TINITALY_TOSC_RASTER_30.tif.aux.xml

Dimensione totale

Sorgente dati

Informazioni dalla

84.01 MB

gdal

sorgente

Estensione

Larghezza

Altezza

Tipo di Dato
Descrizione Driver GDAL
Metadato Driver GDAL
Descrizione dell'insieme
di dati

Compressione

Banda 1

Banda 2

Maggiori informazioni
Dimensioni

Origine

Dimensione Pixel

1554724.6250000000000000.4678304.1895000003278255 : 1771689.4569000001065433,4924789.6789999995380640
7232

8216

Float32 - numero in virgola mobile di 32 bit

GTiff

GeoTIFF

C:/GISeQGIS_DATI/ECDLGIS_SYLLABUS/TINITALY TOSC_RASTER_30.tif

DEFLATE

STATISTICS_APPROXIMATE=YES
STATISTICS_MAXIMUM=2024.8079833984
STATISTICS_MEAN=151.81656609327
STATISTICS_MINIMUM=-1.1056339740753
STATISTICS_STDDEV=265.73548747774
STATISTICS_VALID_PERCENT=100

e Scala: 1
Offset: 0

STATISTICS_APPROXIMATE=YES
STATISTICS_MAXIMUM=255
STATISTICS_MEAN=108.80685780588
STATISTICS_MINIMUM=0
STATISTICS_STDDEV=126.12222815551
STATISTICS_VALID_PERCENT=100

Scala: 1
+ Offset: 0

AREA_OR_POINT=Area

X 7232¥:.8216 Bande: 2
1554724.6250000000000000,4924789.6789999995380640
30.00066812776550051,-30.00066814751694366

Sistema di riferimento (SR)

Nome

Unita
Metodo
Corpo celeste
Riferimento

Bande

EPSG:3003 - Monte Mario / Italy zone 1

metri

Transverse Mercator

Earth

Statico (si basa su un datum che & fissato sulla placca tettonica)

Numero bande

Numero

2

Banda No-Data Min Max
Banda 1 n/d -1.1056335741 2024.8079833984
Banda 2 n/d 0.0000000000 255.0000000000

Cliccando con *7\-% Informazione Elementi all’interno dei confini regionali si ha la quota s.l.m. del tassello cliccato:

‘
Modalita | Layer Corrente

vista | Albero bt

() *PG_SYL_Municipi_Comuni_ComuniDati_REGIONE_3raster — QGIS [ECDL] - O X

Progetto Modifics Visualizza Layer |mpostszioni

[ T4 Jm P & FA 1 (] F e
0 el O P L ] Q= % 2
s~ = ]
e e
Vo lvawmye-aan
Eﬂ’u COMUNI_1997_2011 -
W IGM AICA ENEA TOSC_100k
g AGEA_TOSC_OFC_2013_col_30
5" TINITALY TOSC RASTER 30
9 Banda 1 (Gray)
2.024,81
/e s
17/ O ——— B®
Q- BRRG

& |Bemento Valore
US|~ TINITALY TOSC_ RASTER 30 0
@ = TINITALY_TOSC_RASTER_30
Banda 1 205.35703
ey » (Derivata)
55}
Vo~

Plugins Vettore Raster Database Web Mesh Progessing Guida

Interr rdin| 1663292 4786506 | 2| 12306787 |+ +| 2z [00° 3| V| Visuslizza  @epsizoos @

@ te dingrandime | 100%

By www.giseqgis.it - (2023)
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. i . . 5 . . . . 5 5 . .
Cliccando con Q% Informazione Elementi all’esterno dei confini regionali ma all’interno dell’estensione del raster si ha:

(@ *PG_SYL_Municipi_Comuni_ComuniDati_REGIONE 3raster — QGIS [ECDL] - o X
Progetto  Modifics Visualizza Layer Impostazioni Plugin Vettore Raster Database Web Mesh Processing Guida
=] [ [ T4 B P = DRIORIE)] Il & [ M € =l
0 BhEy O DD® BatMOT &% 2 Y
B
T EE)
Yo |« @l @ T, |2 2
'é COMUNI_1991.2011 -
» [] B IGM AICA ENEA_TOSC_100k
BR |, 1w acea Tosc 0rc 2013 col 30
~ ¥ " TINITALY TOSC RASTER 30
s Banda 1 (Gray)
2.024,81
fa I
||
@3 Informazioni Risultati [EE]
® - 7 B = AN -3 »
@ |Bemenc Valore
~ TINITALY_TOSC_RASTER 30 [
@ | 7 TNTALTOSCRASTER 30
Banda 1 0
@ » (Derivato)
a8 g 0
Modalita | Layer Corrents -
Vista  Albero ot
Q. Digita per e (Ctrl+HY Intern wdin| 1591879 4813078 | 8 2| 12326787 v | @ te dingrandime | 100% 4| az [o0¢ 3| ¥ visualizza  epsia00s @

. I . . Py Py . . . . .
Cliccando con Q% Informazione Elementi all’esterno dell’area di estensione rettangolare del layer non si ha alcuna informazione.

NOTA

Cambiando in _ il _I da _ a _ e scegliendo il numero di classi, gli intervalli e i colori
da assegnare e altre personalizzazioni si potrebbe ottenere una visualizzazione piu leggibile del DTM (come mostrato nell’esercizio
ES_A_TINITALY_TOSC_RASTER 30):
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